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6: Modifying Nodes

 

Arrange-It software allows you to change the way an image is projected or an audio file 
is played in the final presentation. You use the Edit command from the Node menu to 
modify nodes. The Edit Menu Node dialog box contains five editing screens and the Edit 
Sequence Node dialog box contains two editing screens. 

 

■

 

Edit Menu Node

 

 dialog box contains Menu, Image, Sound, Path, and Playback 
modification screens.

 

■

 

Edit Sequence Node

 

 dialog box contains Image and Sound modification screens.

 

Opening a Node Editing Dialog Box

 

You can select editing screens for any node and in any order. You can also make changes 
to several screens before saving and returning to the document window. 

To open a node editing dialog box and display a modification screen:

 

1.

 

Open the node editing dialog box. You can

 

❚

 

Double-click the node in the document window to display the editing dialog box 
for the type of node selected, or 

 

❚

 

Click the node that you want to modify to select it and choose Edit from the Node 
menu.

Depending on the type of node that you selected, either the Edit Menu Node dialog 
box or the Edit Sequence Node dialog box appears.

 

2.

 

Click the appropriate icon in the category list box, located on the left side of the node 
editing dialog box, to display the modification screen.

 

Naming a Node

 

Arrange-It software numbers each node in the presentation sequentially when it is 
created. You can, however, assign a meaningful name to the nodes using the text box that 
displays at the top of both the Edit Menu Node dialog box and the Edit Sequence Node 
dialog box. 

NOTE: Although you can assign a name to the nodes in your presentation, you cannot 
change the node number.
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To name a node:

 

1.

 

Double-click the node in the document window, or click the node to select it and 
choose Edit from the Node menu.

The Edit Menu Node or Edit Sequence Node dialog box appears, depending on the 
type of node selected.

 

2.

 

Enter a name in the text box located at the top of the dialog box.

 

3.

 

Click OK or Cancel.

 

OK

 

 closes the dialog box and displays the name at the top of the node and to the 
right of the node number in the document window.

 

Cancel

 

 closes the dialog box without assigning the name.

 

Editing Menu Nodes 

 

There are five categories of items that can be edited in a menu node. Arrange-It software 
provides an editing screen for each category. 

 

■

 

Menu

 

 modification screen allows you to define menu selection paths and hot spots 
for a menu node.

 

■

 

Image

 

 modification screen allows you to make changes to the way images display.

 

■

 

Sound

 

 modification screen allows you to listen to, get information on, and delete 
audio files.

 

■

 

Path

 

 modification screen allows you to change the destinations of paths associated 
with the menu node.

 

■

 

Playback

 

 modification screen allows you to change the way the player displays the 
image.

 

Menu Node Menu Modification Screen

 

The Menu modification screen from the Edit Menu Node dialog box allows you to define 
menu selection paths and hot spots for a menu node. Menu selections are optional paths 
that can be added to the document.
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To display the Menu modification screen, double-click the menu node in the document 
window. The Menu modification screen appears by default.

The Menu modification screen displays the menu node image and contains the 
following text boxes, list boxes, and buttons:

 

■

 

Node name 

 

text box

 

 

 

lets you name the node.

 

■

 

Menu Item #

 

 drop-down list box shows the active menu Item and a list of items 
associated with the node.

 

■

 

Add

 

 creates a new hot spot and menu Item.

 

■

 

Copy

 

 duplicates the selected hot spot.

 

■

 

Delete

 

 removes the selected hot spot and menu Item.

 

■

 

Hotspot

 

 text boxes show the Top, Left, Height, and Width dimensions (in pixels) for 
the selected menu Item hot spot.

 

■

 

Path

 

 drop-down list box shows the destination of the path connected to the menu 
Item.

 

■

 

Adjust

 

 opens the Adjust Hotspots dialog box.

 

■

 

OK

 

 closes the dialog box and applies the changes.

 

■

 

Cancel

 

 closes the dialog box and discards the changes.

Since Photo CD Portfolio discs can also be viewed on 

 

CD-I

 

 or 

 

3DO

 

 players, which do not 
have a numbered remote control, Arrange-It software lets you create rectangular hot 
spots associated with each menu Item. When the final presentation is viewed on 

 

CD-I 

 

or

 

 
3DO 

 

players, the menu selection is made by using the trackball or joystick and clicking 
inside the associated menu selection hot spot. 

Menu modification screen for 
menu nodes
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Hot spots are visible only in the Menu modification screen and not in the final 
presentation. The hot-spot values display in the text boxes in the Menu modification 
screen.

 

Selecting Menu Items

 

When more than one menu Item is defined, you need to select a menu Item before you 
can modify any of its associated fields. 

To select a menu Item, click the hot-spot frame on the image in the Menu modification 
screen or select the menu Item number from the Menu Item # drop-down list box. The 
hot-spot frame for the selected menu Item highlights on the image in the Menu 
modification screen.

 

Adding and Deleting Menu Items

 

You use the Menu modification screen from the Edit Menu Node dialog box to add or 
delete a menu Item and its associated hot spot. 

To add an Item to an image displayed in the Menu modification screen.

 

1.

 

Click Add in the Menu modification screen.

The arrow pointer changes to a cross and appears on the image.

 

2.

 

Move the cross to the upper-left corner where you want to begin creating a new hot 
spot on the image.

 

3.

 

Press and hold down the mouse button. 

The cross becomes a double-headed arrow. 

 

4.

 

Drag the double-headed arrow down and to the right until it encloses the menu 
Item.

 

5.

 

Release the mouse button when the hot spot encloses the menu Item.

A new menu Item and its hot spot is created. The values displayed in the Menu 
Item # drop-down list box and the four Hotspot text boxes update according to the 
location and size of the new menu Item. 

 

6.

 

Click OK or Cancel.

 

OK

 

 closes the dialog box and an additional menu Item and numbered path tab are 
added to the menu node, producing the same result as clicking the M tab on the 
menu node.

 

Cancel

 

 closes the dialog box without adding a menu Item and numbered path tab.



 

6: Modifying Nodes

 

109

 

To delete a menu Item from the image displayed in the Menu modification screen:

 

1.

 

Click the hot spot for the menu Item that you want to delete. 

You can also select the menu Item number from the Menu Item # drop-down list 
box.

 

2.

 

Click Delete in the Menu modification screen.

The menu Item and its associated hot spot are deleted from the image in the Menu 
modification screen.

 

3.

 

Click OK or Cancel.

 

OK

 

 closes the dialog box and deletes the numbered path from the node.

 

Cancel

 

 closes the dialog box and discards the change.

NOTE: You cannot delete the last menu Item in the Menu modification screen. 
When only one menu Item remains, the Delete button dims.

 

Adjusting Hot Spots

 

The Menu modification screen contains four hot-spot edit boxes that allow you to 
change the size and position of a menu Item hot spot. You can adjust Top, Left, Height, 
and Width dimensions of the hot spot. The values in these edit boxes show in pixels.

You can also reposition the hot-spot frame on the image and view an enlarged image 
when making adjustments to the hot-spot frame.

To adjust the size and position of a hot spot on the image displayed in the Menu 
modification screen:

 

1.

 

Click the hot-spot frame on the image to select it.

 

2.

 

Enter a value in one or more of the dimension and position text boxes.

Height and Width text boxes apply changes to the dimensions of the hot spot.
Top and Left text boxes apply changes to the position of the hot spot.

 

3.

 

Press 

 

ENTER

 

 to see the changes in the frame size and its position on the image.

You can also drag a corner of the hot-spot frame to resize it.

 

4.

 

Click OK or Cancel.

 

OK

 

 closes the dialog box and applies the changes. 

 

Cancel

 

 closes the dialog box and discards the changes.
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To reposition the hot-spot frame on the image displayed in the Menu modification 
screen:

 

1.

 

Click inside the frame.

 

2.

 

Hold down the mouse button and drag the hot-spot frame to reposition it on the 
image.

 

3.

 

Release the mouse button when the hot-spot frame is in the correct position.

 

4.

 

Click OK or Cancel.

 

OK

 

 closes the dialog box and applies the changes.

 

Cancel

 

 closes the dialog box and discards the changes.

You can view an enlargement of the image in the Menu modification screen when 
making adjustments to the hot-spot frame. To view an enlarged image:

 

1.

 

Click Adjust in the Menu modification screen.

The Adjust Hotspots dialog box appears and displays the menu node image 
zoomed to show more detail.

 

2.

 

Click the corner of the hot-spot frame and drag the corner until the hot-spot frame 
is the correct size.

 

3.

 

Click OK to close the Adjust Hotspots dialog box.

 

4.

 

Click OK or Cancel in the Menu modification screen.

 

OK

 

 closes the dialog box and applies the changes.

 

Cancel

 

 closes the dialog box and discards the changes.

Adjust Hotspots dialog 
box

Hot-spot frame
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Defining a Menu Selection Path

 

You use the Menu modification screen from the Edit Menu Node dialog box to define a 
menu selection path for a menu Item.

To define a menu selection path for the image displayed in the Menu modification 
screen:

 

1.

 

Select the menu Item by clicking the Menu Item # drop-down list box and selecting 
a menu Item from the list.

 

2.

 

Select the Path by clicking the Path drop-down list box and selecting a node name 
or number in the list.

 

3.

 

Click OK or Cancel.

 

OK

 

 closes the dialog box and defines the menu selection path. The menu Item 
numbers are renumbered if necessary.

 

Cancel

 

 closes the dialog box and discards the changes.

 

Menu Node Image Modification Screen

 

The Image modification screen from the Edit Menu Node dialog box allows you to make 
changes to the image, view source information for the displayed image, set the delay for 
the length of time before the next image displays or the next audio file plays, and set the 
Image Pac resolution used to copy images onto the Photo CD Portfolio disc. 

Changes made in the Image modification screen can result in a change in the size of the 
image that displays, unlike changes made using the Playback modification screen, 
which modify only the way the player projects the image.

To display the Image modification screen, double-click the menu node in the document 
window and click the Image icon in the category list box.

Image modification screen for 
menu nodes
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The Image modification screen displays the menu node image and contains the 
following text boxes, list boxes, and buttons:

 

■

 

Node name 

 

text box

 

 

 

lets you name the node.

 

■

 

Source Info

 

 displays the Source Information dialog box.

 

■

 

Delay

 

 provides a text box, as well as a drop-down list box of time intervals that 
allows you to select the length of time before the next image displays or the next 
audio file plays.

 

■

 

Image Pac Resolution 

 

displays a drop-down list box of Photo CD Image Pac 
resolutions that allows you to select the maximum resolution of the image that 
copies onto the Photo CD Portfolio disc.

 

■

 

OK

 

 closes the dialog box and applies the changes.

 

■ Cancel closes the dialog box and discards the changes.

Viewing Source Information
To view information about the image displayed in the Image modification screen, click 
the Source Info button. The Source Information dialog box appears containing 
information about the image.

Information shown in the dialog box includes:

■ Collection from which the image was selected

■ Source file

■ Type of image

■ Size of image (in pixels)

■ File size

■ Date the image was last modified

Click OK to close the Source Information dialog box and return to the Image 
modification screen.

Source Information dialog box
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Setting the Delay
You use the Image modification screen to change the length of time before the next 
image displays on the screen, the next audio file plays, or the time-out path is triggered 
in the presentation. The current delay value appears in the Delay text box.

To change the delay value for the image displayed in the Image modification screen:

1. Enter a value in the Delay text box or select a value from the Delay drop-down list 
box. 

Delay intervals range from 0.5 seconds to 300 seconds, as well as No Delay and 
Infinite Delay.

No Delay displays the next image, plays the next audio file, or triggers the time-out 
without any delay.

Infinite Delay waits for the viewer to make a selection before displaying the next 
image or playing the next audio file.

2. Click OK or Cancel.

OK closes the dialog box and sets the delay.

Cancel closes the dialog box and discards the delay change.

Image modification screen 
with Delay drop-down list box
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Setting Image Pac Resolution
The Image modification screen contains the Image Pac Resolution drop-down list box 
that provides a list of resolutions used to copy images onto the Photo CD Portfolio disc. 

To select the Image Pac resolution for the image displayed in the Image modification 
screen:

1. Click the Image Pac Resolution list box and select a resolution from the list. 

2. Click OK or Cancel.

OK closes the dialog box and sets the resolution. 

Cancel closes the dialog box and discards the changes.

Menu Node Sound Modification Screen
The Sound modification screen allows you to view source information for the audio file 
in a menu node, play an audio file, delete the audio file, and set the delay.

To display the Sound modification screen, double-click the menu node in the document 
window and click the Sound icon in the category list box.

Image modification screen 
with Image Pac Resolution 
drop-down list box

Sound modification screen for 
menu nodes
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The Sound modification screen contains the following text box, list box, and 
information:

■ Node name text box lets you name the node.

■ Source Info displays the Source Information dialog box.

■ Play Sound plays the audio file.

■ Delete Sound deletes the audio file.

■ Delay provides a text box, as well as a drop-down list box that allows you to select 
the length of time before the next image displays or the next audio file plays.

■ Playback Length shows the length of the currently selected audio file.

Viewing Source Information
To view information about the selected audio file in the Sound modification screen, click 
the Source Info button.The Source Information dialog box appears containing 
information about the audio file.

Information shown in the dialog box includes: 

■ Collection from which the audio file was selected

■ Source file

■ Type of file (sound)

■ Size (duration of the audio file in seconds)

■ File size

■ Date the audio file was last modified

Click OK to close the Source Information dialog box and return to the Sound 
modification screen.

Source Information dialog box
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Playing an Audio File
To play the selected audio file in the Sound modification screen, click the Play Sound 
button. You can play the entire audio file or you can click anywhere in the Sound 
modification screen to stop the playback.

Deleting an Audio File
To delete the audio file from the Sound modification screen:

1. Click Delete Sound. 

The audio file is deleted and NO AUDIO replaces the speaker icon in the Sound 
modification screen.

2. Click OK or Cancel.

OK closes the dialog box and sets the changes. 

Cancel closes the dialog box and discards the changes.

Setting the Delay
You can use the Sound modification screen in the Edit Menu Node dialog box to change 
the length of time before the next image displays on the screen, the next audio file plays, 
or the time-out path is triggered in the presentation. The current delay value displays in 
the Delay text box.

To change the delay value for the audio file in the Sound modification screen:

1. Enter a value in the Delay text box or select a value from the Delay drop-down list 
box. 

Delay intervals range from 0.5 seconds to 300 seconds, as well as No Delay and 
Infinite Delay.

No Delay displays the next image, plays the next audio file, or triggers the time-out 
without any delay.

Infinite Delay waits for the viewer to make a selection before displaying the next 
image or playing the next audio file.

2. Click OK or Cancel.

OK closes the dialog box and sets the delay.

Cancel closes the dialog box and discards the delay change.
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Menu Node Path Modification Screen
The Path modification screen from the Edit Menu Node dialog box allows you to make 
new path connections or change the destinations of paths associated with the selected 
node.

To display the Path modification screen, double-click the menu node in the document 
window and click the Path icon in the category list box.

The node numbers or names for the Previous, Next, Time-out, and Error paths display 
in the respective drop-down list boxes. You can also use these list boxes to make new 
connections or to replace existing ones.

■ Previous indicates which node displays when the Previous button is selected on the 
player remote control.

■ Next indicates which node displays when the Next button is selected on the player 
remote control.

■ Time-out indicates which node will display if the user does not make a menu 
selection in a predetermined amount of time.

■ Error is the path to the node that displays if an error has been made when selecting 
a menu path.

To change a path or make a new connection:

1. Click the drop-down list box for the path that you want to change.

A list of all nodes for the selected path displays.

2. Select the node number or name that you want as the new destination node.

The path list box updates to display the new path number or name.

Path modification screen for 
menu nodes
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3. Click OK or Cancel.

OK closes the dialog box and the updates the path.

Cancel closes the dialog box without updating the path.

Menu Node Playback Modification Screen
The Playback modification screen from the Edit Menu Node dialog box allows you to 
change the way the player displays the image. You use this screen to set the transition 
for the way one image replaces the next image during your presentation and to set the 
display resolution.

When you make modifications to an image using the Playback modification screen, you 
are not actually modifying the image—you are only modifying the way the player 
projects the image on the screen.

To display the Playback modification screen, double-click the menu node in the 
document window and click the Playback icon from the category list box.

The Playback modification screen contains the following text box, list boxes, and 
buttons:

■ Node name text box lets you name the node.

■ Transition displays a drop-down list box that allows you to select the way the next 
image replaces the current image.

■ Display Resolution displays a drop-down list box of available resolutions for the 
image in the node.

❚ Always option button allows the selected player to play back an image at the 
selected resolution at the normal speed of the player for that resolution.

Playback modification screen 
for menu nodes
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❚ Or Better option button allows the selected player to play back an image at the 
highest possible resolution at the normal speed of the player for that resolution.

■ OK closes the dialog box and applies the changes.

■ Cancel closes the dialog box and discards the changes.

Setting the Transition
You use the Transition drop-down list box from the Playback modification screen to 
change the transition for the menu node image. The transition describes how the next 
image in your presentation replaces the currently displayed image.

NOTE: Not all player models support transition changes. Refer to your player manual 
for transitions supported by your player. Similarly, the Arrange-It software 
Preview Presentation may not display images using the selected transition if 
the player you selected does not support the transition.

To change the transition for the image displayed in the Playback modification 
screen:

1. Click the Transition drop-down list box and select a new transition from the list.

The currently selected transition appears highlighted in the list.

2. Click OK or Cancel.

OK closes the dialog box and applies the transition. 

Cancel closes the dialog box and discards the change.

Setting the Display Resolution
You use the Display Resolution drop-down list box from the Playback modification 
screen to select the image resolution for the image in the menu node. When you select 

Playback modification 
screen with Transition 
drop-down list box
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the display resolution, you must also click either the Always option button or the Or 
Better option button.

The image resolution that you select from the Display Resolution drop-down list box 
should be based on the length of time it takes to read and display an image. Resolutions 
and the time to display the image at that resolution include:

■ BASE / 16 (192 x 128 pixels) resolution (not yet supported by most players).

■ BASE / 4 (384 x 256 pixels) resolution takes approximately two seconds.

■ BASE (768 x 512 pixels) resolution takes approximately four seconds.

■ BASE * 4 (1536 x 1024 pixels) resolution (not yet supported by most players).

■ BASE * 16 (3072 x 2048 pixels) resolution (not yet supported by most players).

NOTE: On players that support these higher resolutions, as you increase the quality of 
the image resolution, you also increase the time it takes the image to be drawn 
on the screen. Conversely, as you decrease the time to displays an image, you 
also decrease the image quality.

To change the display resolution for the image displayed in the Playback screen:

1. Click the Display Resolution drop-down list box and select the desired resolution 
from the list.

The currently selected resolution appears highlighted in the list.

2. Click either the Always option button or the Or Better option button.

3. Click OK or Cancel.

OK closes the dialog box and applies the resolution change.

Cancel closes the dialog box and discards the change.

Playback modification screen 
with Display Resolution drop-
down list box
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Editing Sequence Nodes
There are two categories of items that can be edited in a sequence node. Arrange-It 
software provides an editing screen for each category.

■ Image modification screen allows you to make changes to the images and the way 
they display in the presentation.

■ Sound modification screen allows you to edit audio files.

When you first open an Edit Sequence Node dialog box, either the Image modification 
screen or the Sound modification screen displays, depending on whether the first item 
in the sequence node is an image or an audio file.

Sequence Node Image Modification Screen
The Image modification screen from the Edit Sequence Node dialog box allows you to 
change the way the player displays the image. You use this screen to set the Image Pac 
resolution, display resolution, delay, and transition for the way one image replaces the 
next image during the presentation.

To edit an image in an Image modification screen, double-click a sequence node in the 
document window and select an image from the Image/Audio bar.

The Image modification screen contains the following text boxes, list boxes, and buttons:

■ Node name text box lets you name the node.

■ Sequence width text box allows you to select the maximum number of files in the 
sequence node that display in the document window without scrolling.

Image modification screen for 
sequence nodes
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■ Image/Audio bar contains the images and/or audio files in the sequence node.

■ Image Preview shows the file that you selected from the Image/Audio bar.

❚ Tele In reduces the size of the TV crop box and enlarges the image. The 
magnification number displays just above the Tele In button. 

When you click Tele In to enlarge the size of your image, the TV crop box shows 
you how much of the perimeter of your image will be cropped for presentation 
in the Arrange-It software Emulate/Display window or on the player. The area 
inside the crop box indicates the maximum portion of the image that might 
appear on a television.

Not all players use the same zoom factors. Results may vary when you play back 
the image.

❚ Tele Out enlarges the size of the TV crop box and reduces the image. Not all 
players use the same zoom factors. Results may vary when you play back the 
image.

❚ Rotate rotates the image 90 degrees at a time.

❚ Reset resets the Tele In, Tele Out, and Rotate changes to the original settings.

■ Image Pac Resolution displays a drop-down list box of Photo CD Image Pac 
resolutions that allows you to select the maximum resolution of the image that 
copies onto the Photo CD Portfolio disc.

■ Display Resolution displays a drop-down list box of available resolutions in which 
you can display the image.

❚ Always option button allows the player to play back an image at the selected 
resolution at the normal speed of the player for that resolution.

❚ Or Better option button allows the selected player to play back an image at the 
highest possible resolution, at the normal speed of the player for that resolution.

■ Delay provides a text box, as well as a drop-down list box of time intervals that 
allows you to reset the length of time before the next image or audio file plays.

■ Transition displays a drop-down list box that allows you to select how the next 
image replaces the current image.

■ Source Info displays the Source Information dialog box.

■ Delete Image deletes the selected image.

■ Previous drop-down list box displays the node names or numbers connected to the 
Previous path tab on the sequence node.
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■ Next drop-down list box displays the node names or numbers connected to the Next 
path tab on the sequence node.

■ OK closes the dialog box and applies the changes.

■ Cancel closes the dialog box and discards the changes.

Setting the Image Pac Resolution
You use the Image Pac Resolution drop-down list box in the Image modification screen 
to select the resolution used to copy images onto the Photo CD Portfolio disc.

To select the Image Pac resolution for the image displayed in the Image modification 
screen:

1. Click the Image Pac Resolution list box and select a resolution from the list. 

The currently selected resolution displays highlighted in the list.

2. Click OK or Cancel.

OK closes the dialog box and sets the resolution.
Cancel closes the dialog box and discards the change.

Setting the Display Resolution
You use the Display Resolution drop-down list box from the Image modification screen 
to select the image resolution for the image in the sequence node. When you select the 

Image modification screen 
with Image Pac Resolution 
drop-down list box
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display resolution, you must also click either the Always option button or the Or Better 
option button.

The image resolution that you select from the Display Resolution drop-down list box 
should be based on the length of time it takes to read and display an image. Resolutions 
and the time to display the image at that resolution include:

■ BASE / 16 (192 x 128 pixels) resolution (not yet supported by most players).

■ BASE / 4 (384 x 256 pixels) resolution takes approximately two seconds.

■ BASE (768 x 512 pixels) resolution takes approximately four seconds.

■ BASE * 4 (1536 x 1024 pixels) resolution (not yet supported by most players).

■ BASE * 16 (3072 x 2048 pixels) resolution (not yet supported by most players).

NOTE: On players that support these higher resolutions, as you increase the quality of 
the image resolution, you also increase the time it takes the image to be drawn 
on the screen. Conversely, as you decrease the time to display an image, you 
also decrease the image quality.

To change the display resolution for the image displayed in the Image modification 
screen:

1. Click the Display Resolution drop-down list box and select the desired resolution 
from the list box.

The currently selected resolution appears highlighted in the list.

2. Click either the Always option button or the Or Better option button.

Image modification screen 
with Display Resolution drop-
down list box
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3. Click OK or Cancel.

OK closes the dialog box and sets the resolution.

Cancel closes the dialog box and discards the change.

Setting the Delay
You use Delay drop-down list box in the Image modification screen to change the length 
of time before the next image displays on the screen, the next audio file plays, or the 
time-out path is triggered in the presentation. The current delay value displays in the 
Delay text box.

To change the delay value for the image displayed in the Image modification screen:

1. Enter a value in the Delay text box or select a value from the Delay drop-down list 
box. Delay intervals range from 0.5 seconds to 300 seconds, as well as No Delay and 
Infinite Delay.

No Delay displays the next image, plays the next audio file, or triggers the time-out 
without any delay.

Infinite Delay waits for the viewer to make a selection before displaying the next 
image or playing the next audio file.

2. Click OK or Cancel.

OK closes the dialog box and sets the delay.

Cancel closes the dialog box and discards the delay change.

Image modification screen 
with Delay drop-down list box
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Setting the Transition
You use the Transition drop-down list box from the Image modification screen to change 
the transition for sequence node images. The transition describes how the next image in 
your presentation replaces the currently displayed image. 

NOTE: Not all player models support transition changes. Refer to your player manual 
for transitions supported by your player. Similarly, the Arrange-It software 
Preview Presentation may not display images using the selected transition if 
the player you selected does not support the transition.

To change the transition for the image displayed in the Image modification screen:

1. Click the Transition drop-down list box and select a new transition from the list.

The currently selected transition appears highlighted in the list.

2. Click OK or Cancel.

OK closes the dialog box and applies the transition.

Cancel closes the dialog box and discards the change.

Image modification screen 
with Transition drop-down 
list box
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Viewing Source Information
To view information about the image displayed in the Image modification screen, click 
the Source Info button. The Source Information dialog box appears containing 
information about the image.

Information shown in the dialog box includes:

■ Collection from which the image was selected

■ Source file

■ Type of image

■ Size of image (in pixels)

■ File size

■ Date the image was last modified

Click OK to close the Source Information dialog box and return to the Image 
modification screen.

Deleting an Image
To delete an image displayed in the Image modification screen:

1. Click the Delete Image button. 

The image is deleted and the Image/Audio bar displays the altered sequence node.

NOTE: When only one image is left in a sequence node, the Delete Image button 
dims.

2. Click OK or Cancel.

OK closes the dialog box and deletes the image.

Cancel closes the dialog box and retains the image.

Source Information dialog box
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Sequence Node Sound Modification Screen
The Sound modification screen from the Edit Sequence Node dialog box allows you to 
control the length of time before the next audio file plays, the next image displays on the 
screen, or the time-out path is triggered. The current value displays in the Delay text box.

To edit an audio file in the Sound modification screen, double-click a sequence node in 
the document window and select a sound file from the Image/Audio bar.

The Sound modification screen contains the following text boxes, list boxes, and buttons:

■ Node name text box lets you name the node.

■ Sequence width text box shows the maximum number of files in the sequence node 
that display in the document window without scrolling.

■ Playback Length shows the length of the currently selected audio file.

■ Delay provides a text box, as well as a drop-down list box that allows you to select 
the length of time before the next image displays or the next audio file plays.

■ Source Info displays the Source Information dialog box.

■ Play Sound plays the audio file.

■ Delete Sound deletes the audio file.

■ Previous drop-down list box displays the node names or numbers connected to the 
Previous path tab on the sequence node.

Sound modification screen for 
sequence nodes
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■ Next drop-down list box displays the node names or numbers connected to the Next 
path tab on the sequence node.

■ OK closes the dialog box and applies the changes.

■ Cancel closes the dialog box and discards the changes.

Setting the Delay
You use the Delay drop-down list box in the Sound modification screen to change the 
length of time before the next image displays on the screen, the next audio file plays, or 
the time-out path is triggered in the presentation. The current delay value displays in the 
Delay text box

To change the delay value for the sound file in the Sound modification screen:

1. Enter a value in the Delay text box or select a value from the Delay drop-down list 
box. Delay intervals range from 0.5 seconds to 300 seconds, as well as No Delay and 
Infinite Delay.

No Delay displays the next image, plays the next audio file, or triggers the time-out 
without any delay.

Infinite Delay waits for the viewer to make a selection before displaying the next 
image or playing the next audio file.

2. Click OK or Cancel.

OK closes the dialog box and sets the delay.

Cancel closes the dialog box and discards the delay change.

Sound modification screen 
with Delay drop-down list box
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Viewing Source Information
To view information about the audio file in the Sound modification screen, click the 
Source Info button. The Source Information dialog box appears containing information 
about the audio file.

Information shown in the dialog box includes:

■ Collection from which the audio file was selected

■ Source file

■ Type of file (sound)

■ Size (duration of the audio file in seconds)

■ File size

■ Date the audio file was last modified

Click OK to close the Source Information dialog box and return to the Sound 
modification screen.

Playing an Audio File
To play the audio file in the Sound modification screen, click the Play Sound button. You 
can play the entire audio file or click anywhere in the Sound modification screen to stop 
the playback.

Deleting an Audio File
To delete an audio file in the Sound modification screen:

1. Click the Delete Sound button. 

The audio file is deleted from the Image/Audio bar. 

2. Click OK or Cancel.

OK closes the dialog box and deletes the audio file.

Cancel closes the dialog box and retains the audio file.

Source Information dialog box
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